DGIST Spring I 2023 Admissions

Application Guidelines

DGV

Last update 2022. 5. 6.



Timeline
Application June 16t ~ July 7th | 2022 Submission of application(Online)

Release of | Admissions Website
) : July 28th, 2022 |
Document Screening Results y § (https://dgist.ac.kr/iadm/)

Interview August 3 ~ August 12th, 2022 Online Interview

- o Admissions Website
Release of Admissions Decisions August 29th, 2022 5 (https://dgist.ac.krliadm/)

Eligibility

- v Students who hold bachelor’s degrees or are expected to complete
M.S. / Integrated M.S. & Ph.D.

their bachelor’s degree

Ph.D v' Students who hold master’s degrees or are expected to complete

their master’s degree

v' Additionally, students for ‘General Scholarship’ also need to be recommended by the head of their institutions (company, institute, etc.).




Department/Major & Program

Department/Major Scholarship

Physics and Chemistry
Electrical Engineering and Computer Science

Robotics and Mechatronics Engineering Government Scholarship

M.S.

Energy Science and Engineering or

Brain Sciences Integrated M.S.&Ph.D.

| General Scholarship |
New Biology Ph.D.

Artificial Intelligence major
in Interdisciplinary Studies

Interdisciplinary Engineering major DGIST Scholarshi
in Interdisciplinary Studies | P

X There's a chance that applicants who applied for Integrated M.S.&Ph.D. program may get admission to M.S. program depending on the evaluation results.
X Employed applicants have to apply for ‘General Scholarship’. Applicants who are currently employed can apply ‘Government Scholarship’ or

‘DGIST Scholarship’ only if they retire before admissions.

[ Website of Each Department(Major) ]

- Physics and Chemistry : http://[physchem.dgist.ac.kr

- Electrical Engineering and Computer Science : http://eecs.dgist.ac.kr

- Robotics and Mechatronics Engineering : http://robot.dgist.ac.kr

- Energy Science and Engineering : http://energy.dgist.ac.kr

- Brain Sciences : http://brain.dgist.ac.kr - New Biology : http://Inb.dgist.ac.kr
- Interdisciplinary Engineering : http://interdisciplinary.dgist.ac.kr

- Artificial Intelligence : http://ai.dgist.ac.kr




Application Documents

Compulsory Documents to Submit

Fill out the online application page
- Application Form must be written in English

Application Form & - Statement of Purpose can be written in English, Korean or Both

Statement of Purpose (SOP)
(prescribed form)

(expected) Degree Certificate - M.S./ Integrated M.S. & Ph.D. Applicant : Undergraduate degree certificate

apostille - Ph.D. Applicant : Both Undergraduate and Graduate degree certificates
authenticated in Korean embassy i X Please submit certificate of enrollment if you can not hand in certificate of (expected) graduation.

Official Transcript - M.S./ Integrated M.S. & Ph.D. Applicant : Undergraduate official transcript

apostille - -Ph.D. Applicant : Both Undergraduate and Graduate official transcripts
authenticated in Korean embassy * For New Biology applicants: official transcripts must include a class rank

Optional Documents to Submit

Enalish Profici Certificate TOEIC, TOEFL, IELTS, TEPS etc. (only official certificates are allowed)
ngiis iciency Lerunca * for Physics and Chemistry / New Biology / Interdisciplinary Engineering major

Certificate of Employment &
Recommendation Letter from
Others (Company, Institute, etc.)

‘Recommendation Letter from Others’ should be written in the prescribed form
X for General Scholarship applicants

Other Certificates Other certificates that show the applicant’s capability and possibility

Letter of Recommendation Direct submission from the evaluator via e-mail (admission@dgist.ac.kr)
(prescribed form) . by 17:00, July 7t — no limitation on the number of recommendation letters




Application Documents

Compulsory Documents to Submit

Those documents must be written in English and
uploaded in one merged PDF file(under 8MB) on online application page

(expected) Degree Certificate - M.S./ Integrated M.S. & Ph.D. Applicant : Undergraduate degree certificate

apostille - Ph.D. Applicant : Both Undergraduate and Graduate degree certificates
authenticated in Korean embassy i X Please submit certificate of enrollment if you can not hand in certificate of (expected) graduation.

Official Transcript - M.S./ Integrated M.S. & Ph.D. Applicant : Undergraduate official transcript

apostille - -Ph.D. Applicant : Both Undergraduate and Graduate official transcripts
authenticated in Korean embassy * For New Biology applicants: official transcripts must include a class rank

Optional Documents to Submit

TOEIC, TOEFL, IELTS, TEPS etc. (only official certificates are allowed)
* for Physics and Chemistry / New Biology / Interdisciplinary Engineering major

English Proficiency Certificate

Certificate of Employment &
Recommendation Letter from
Others (Company, Institute, etc.)

‘Recommendation Letter from Others’ should be written in the prescribed form
X for General Scholarship applicants

Other Certificates Other certificates that show the applicant’s capability and possibility

X Do not put your letters of recommendation in the PDF file. The letters should be submitted directly by the evaluator.




English Proficiency Certificate Exemption

Applicants who meet one of the following conditions

do not have to submit official English proficiency certificate.

1. Applicants who completed their degree programs in English speaking countries* or

countries whose official language is English**

* Australia, Canada, Guyana, Ireland, New Zealand, United Kingdom, United States
** Certificate showing that the applicants have completed their degree programs in English have to be submitted.

If the certificate is proven to be a forgery or false document, the admissions will be canceled.

2. Applicants who have already been admitted their English proficiency in DGIST Graduate

School Admissions.




Letter of recommendation

O by the evaluator
O E-mail submission (admission@dgist.ac.kr) by 17:00, July 7t - KST

O No limitation on the number of recommendation letters

1.Download the prescribed form from Admissions website.

» p p Download the form : https://dgist.ac.kr/iadm/ — Information — Archive

2. Fill out the “Part 1” with your signature.
3. Give this form to your evaluator.
4. Let your evaluator finish the “Part 2”.

5. Let your evaluator send this form in PDF to DGIST by e-mail (admission@dgist.ac.kr).

X Please avoid to use the domain ‘163.com’ as our security program detect it as a junk mail.



https://dgist.ac.kr/iadm/
mailto:admission@dgist.ac.kr

Admissions Procedure
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Document
Screening

Interview
Evaluation

Only for those who passed
the document screening

Registration

Only for those who passed
the interview evaluation

@ Application & Statement of Purpose must be input into the online application page.
For the other documents, make a single PDF file and upload it on the online application page.
All application procedure should be completed by 17:00, July 7""— KST.

@ The application link will be opened at 10:00, June 16" - KST,

X Application fee is 50 USD / 50,000KRW (including the commission 5,000 KRW)
and not refundable. Only Visa card is available for payment with credit card.

Evaluation of the potential academic ability based on former college/graduate school’s
transcript, statement of purpose, etc.

Evaluation of fundamental knowledge of the field of study, enthusiasm for research, potential
ability to be a scholar, and communication ability through individual and/or group interviews.

* Online interview can be arranged for international students by an early request.

Online registration & Submission of original documents

> Dual enrollment(registration) is strictly prohibited for DGIST Graduate School.
You will be expelled from DGIST if you are with dual registration.
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1. Disable Pop-up blockers

i ) Open Internet Explorer.
ii) Click the Tools menu, and then click Internet Options.
iii) On the Privacy tab, uncheck Turn on Pop-up Blocker.

iv) Click Apply & OK, and then close Internet Explorer.

— Options |
ac Search p - iy General | Seturl Content C cti Programs  Ad d
Print Settings
File » Sites Advanced
Zoom (1 05%:] » Location
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I Internet options
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2. Enable Active X controls download

i ) Open Internet Explorer.

ii) Click the Tools menu, and then click Internet Options.

iii) On the Security tab, click the Custom level button.

iv) Scroll down the Security Settings list until you see ActiveX controls and plug-ins.

v) Enable ®MAutomatic prompting for ActiveX controls, @Download unsigned ActiveX controls,
@Download signed ActiveX controls, @WRun ActiveX controls and plug-ins, ®Script ActiveX controls

marked safe for scripting

Internet Options ? *
Security Settings - Internet Zone X
H C | H k O K d th ' H k O K H Gi | Privacy Content Connections Programs Advance d
eeeee
\"A) IC , an en Clic again. Settngs
Select a zone to view or change security settings. @] ActiveX controls and plug-ins ~
P ° . - P — |#| Allow ActiveX Filtering
vii) Close Internet Explorer and start it again. @ ¢ v O O psese
Ints i L |:“tr t  Trusted site: Restricted @ Enable
ocalinranet - lrusted sites E:m':s |¢| Allow previously unused ActiveX controls to run without prom
(®) Disable
IThnternet . X Sites () Enable
is zone is for Internet websites, I
@ except those listed in trusted and (9] Allow .Scnptiets
restricted zones. @ Disable
(O Enable
Security level for this zone Q Prnm.nr - —
|¢| Automatic prompting for ActiveX controls
() Disable
Custom @
Custom settings. BTy AT SO T DT
- To change the settings, dick Custom level, S A i o v
To use the recommended settings, dick Default lex&l, < >

*Takes effect after you restart your computer

tepriet Explorer)
Reset custom settings

Default level .
Resetto:r | Medium-high (default) v Reset...




1. Visit the application website

2. Click the button ‘Sign Up’
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3. Check the box and click the button ‘Agree’

UT'U'ay Apply Uwayapply | Customer Center ENGLISH v

Create an Account

On the site of Uwayapply.
You can only sign up for the membership when you agree with the above
items in order for systematic member information maintenance.

Agreement for Service User Fullte:t

Article 1 (Purpose) ~
Az using all services(hereinafier referred to as “service”) provided by
|kway apply.Com which Uwayapply Co., Ltd. (hereinatter referred to as
“Company”) operate, the terms are to define the rights and duties and v

I, 1 R O, (R S PRty Sy

Wl you agree on the terms and conditions mertioned above?

The range of collection of personal information Fulltext

1. The purpose of personal information collection and use, List and ~
method of collection

The purpose of
collection - use

v

List to collect Method to collect

Wl you agree on the terms and conditions mertioned above?

Notice and Precaution

You have Hght to disagree of collect and use your personal information, if you do, can't join
Uy apply

Disagree Agree




4. Fill in the chosen form and click the button ‘confirm’

User Information

Please check joined record in Uwayapply before writing

Yes, | have a phone number No, | don’t have a phone number

Name
Flease enter your name without blanks,

Date of birth Selectﬂ Year Selectﬂ Faonth Select|s| Day
Flease write date of birth wour own.

E-mail @ Select vl

Flease enter vour exact E-mail.




5. Fill in the form and click the button ‘Confirm’

Create your Account

Uwayapply always care members information and never open any information to the others without permission.
Your written information will be axacthy use for your documents, 2o please write correct information.

= Mue mis ou
“Mame DGEIET
“ID Confirm 1D
“Password
* IIx with siphabet+number+apecial symool, cheracieristice under &~12

« Ezpecially Elpnebet, dizUNguisn Trom capital letier £ For 2pacial aymial,
only can use [~ERd s el _—={}11" 0.

« Mot use more than 4 consecutive or duplicale characters, numbers.

“Confinm password
“Date of birth 2004 “ear 09 Month 07 Day Lunar
“Gender Iale Femals
Phone No Select j - -
Mobile No - -
aKT KT LEU+ ETC

D Agres 1o recsipt nformeton/ S8 related to Epgiication.

“E-mail sdmigslon@agist.ac.kr

l:l AQres 1o recslpt smell for Infarmation of applicetion End news.

Cancel Confirm



Application Page

1. Visit the application website

2. Click the button ‘APPLICATION’ at the bottom of the webpage

#HA=Hd5t7| APPLICATION




Application Page
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Application Page

5. Fill in the application form and check the boxes
X If you do not have cell phone number, please input 010-0000-0000

6. Click the button ‘SAVE’

7. Click the button ‘PERSONAL STATEMENT’

You can modify your application form before payment completed.

£M35t7| MODIFY




Statement of Purpose

1. Check the box which language you write in.

2. Fill out the form.

3. Click the button ‘SAVFE’

Z8517| Modify X&st7| Save

4. Click the button ‘Pay’
You can modify your Statement of Purpose by 17:00, July 7t,

(even after payment completed)

+=&3s}7| Modify ZHI5t7| Pay

X Application fee is 50,000KRW including the commission and it will appear after you click
the button ‘Pay’ in the table about payment.




Payment

1. Click the button ‘International credit card’

International credit card

ol 2| 2 A

2. Read through the message for 3D authorization

X If you struggle with payment procedure, please contact your card company to get the authorization.

3. Check the box ‘Agree to all’ and click ‘Next’
4. Proceed the payment with VISA card

If you have problems with payment process,
please contact Uwayapply.(+82 1588-8988)

v

- 2y 20| EAH0|HX 1544-T772

@ payments Credit card

Terms guidance

General Terms and Conditions for Electronic @ [] Subseribe to
Financial Transactions

General Terms and Conditions for Electronic Financial Transactions

(for users)

Article 1 (Objective) v
The objective of these Terms and Conditions is to provide stability

Consent for Personal Information Collection and @ [] Subscribe to

Use

Consent for Personal Information Collection and Use ~
Toss Payments Co., Ltd. (hereinafter, “the Company”) collects and uses
personal information of users of communications fee/electronic v

financial services (hereinafter, “users”) as follows pursuant to the

Consent for Providing Personal Information and @ [ Subseribe to
Consignment

Consent for Providing Personal Information and Consignment ~
1. Toss Payments Co., Ltd. (hereinafter, “the Company”) provides
and consigns personal information collected by users of
communications fee/electronic financial services to third parties as

Next >

~ 3D certification

= Customers can use their credit cards after registering their
card information and personal confirmation message for
3D certification payment system at the card issuance
company website{or the bank issued the credit card).
- If that card issuance company website does not offer 30
certification, customers cannot pay with that card through
online.

Ex) for BC-VISA card, please use BC card website for

certification. Customers may use I1SA website, as well.
- JCB, DINES, AMEX cards cannot be used as they do not
offer VISA 3D certification.

v ABIIE HRH2?

What is the credit card payment?

YS! ZE BEES YAIHOM FH MM T UL By
022 MOl Ml YR W 80K F2L UG R.
(The credit card payment is made in such method that all
the information are directly entered by a paying entity
rather than us, and accordingly, trade information are not
recorded at all. Please feel assured.

(ISP} L HIAYAUBY FHZ 2O HWE BAI 7HESI,
CiS22 FAEMIM YRHE ATt 7He St EOH H2|3 R s
< SAGLICH FEEAMEE | W ol YolsiL| HEAN Helsin FX
BHA| .

(ISP is safer method of payment that general credit card
payment. As each credit card company has different policy




Inquiries about
Online application : +82 1588-8988
D

GIST Admissions : +82 53-785-5143,
admission@dgist.ac.kr

DGV



